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กำรติดตั้ง (Setup) 
 
 ความก่อนท่ีจะเร่ิมติดตั้งระบบ หอ้งสมุดอตัโนมติั “ELIB” จะตอ้งทราบตอ้งการพ้ืนฐานของระบบทั้งฮาร์ดแวร์
และซอฟตแ์วร์ โดยมีรายละเอียดดงัน้ี 

 

ควำมต้องกำรของระบบ 
เคร่ืองแม่ข่าย : 
 Hardware 

- โปรเซสเซอร์ Xeon ข้ึนไป 
- หน่วยความจ า ขั้นต ่า 4 GB แนะน า 8 GB  
- พ้ืนท่ีวา่งของ Hard disk อยา่งนอ้ย 500 GB ส าหรับ ติดตั้ง Microsoft SQL Server 5 GB ส าหรับติดตั้งโปรแกรม 

ELIB 500 MB ส าหรับฐานขอ้มูล 500 GB( ข้ึนอยูก่บัปริมาณทรัพยากรท่ีจะลงรายการ ) และ อยา่งน้อย  1 TB 
ในกรณีท่ีตอ้งการ จดัเก็บส่ือผสมอ่ืน ๆ เช่น ภาพประกอบ, ส่ือวดีีโอ ฯลฯ 

- Tape Backup 
- CD-ROM Drive 
- Monitor และอุปกรณ์ต่อพว่งอ่ืน ๆ ท่ีจ าเป็น 

 Software 
- ระบบปฏิบติัการ Windows 2008 R2 Server  ข้ึนไป 
- โปรแกรมจดัการฐานขอ้มูล Microsoft SQL Server 2008 R2 ข้ึนไป 
- NET Framework ( ข้ึนกบั version ของระบบปฏิบติัการ และ โปรแกรมจดัการฐานขอ้มูล ) 
- Internet Information Services version 7.0 ข้ึนไป 
- Internet Brower ขั้นต ่า Internet Explorer 6Service Pack 1 เพื่อความสมบูรณ์ของภาษาไทย 

 

เคร่ืองลูกข่าย : 
 Hardware 

- เคร่ืองท่ีสามารถรองรับปฏิบติัการ  Windows 7 ข้ึนไป 
- Monitor และอุปกรณ์ต่อพว่งอ่ืน ๆ ท่ีจ าเป็น 

 Software 
- ระบบปฏิบติัการ Windows 7  ข้ึนไป 
- Internet Brower ขั้นต ่า Internet Explorer 6Service Pack 1 เพื่อความสมบูรณ์ของภาษาไทย 
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กำรติดตั้งระบบทีเ่คร่ืองแม่ข่ำย 
 การติดตั้ งระบบ ท่ีเคร่ืองแม่ข่ายจะเป็นการติดตั้ งในส่วนของระบบสืบค้น (OPAC) และระบบลงรายการ 
(CATALOG)  
1.คลิก Setup.exe เลือก Next 
 
 
 

 
 
 
 
 
 
 
 
2. เลือก Directory ท่ีตอ้งการติดตั้งโปรแกรม ในกรณีท่ีตอ้งการติดตั้ง ELIB Files ไวใ้น Directory ช่ืออ่ืน สามารถท าไดโ้ดย
คลิกท่ีปุ่ม Browse (ควรจะติดตั้ง ELIB Files ไวใ้น Directory ช่ือ ELIB เพื่อความสะดวกในการดูแลระบบ) 
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3. เลือก Install รอจนการติดตั้งเสร็จสมบูรณ์ 
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ELIB Virtual website Setup 
 เน่ืองจากระบบห้องสมุดอตัโนมติั ELIB เป็นระบบท่ีท างานในลกัษณะ Web - Base Application เพราะฉะนั้น
นอกจากการติดตั้งระบบฯ ในเคร่ืองแม่ข่ายแลว้ จะตอ้งท าให้ระบบฯ สามารถใชง้านผา่นเครือข่ายอินเตอร์เน็ตได ้โดยเพ่ิม
และสามารถก าหนดไดท่ี้ “Internet Services Manager” โดยมีขั้นตอนดงัน้ี 
1. จากหนา้จอทางดา้นซา้ย, คลิกปุ่มขวาของ mouse ท่ี Default Web Site  คลิก AddVirtual Directory ตามรูปดา้นล่าง 

 
2. จะปรากฏหนา้จอ Add Virtual Directory  ในช่อง Alias ใหพ้ิมพ ์elib และใหเ้ลือก Path ท่ีตอ้งการเช่ือมโยง ( คือ Path ท่ี
ไดติ้ดตั้งโปรแกรม ELIB เช่น “D:\ELIB\elib” ) โดยการคลิกปุ่ม  Browse เพื่อเลือก Path ท่ีตอ้งการ คลิก OK 
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3. จากนั้นคลิกท่ีเคร่ือง Server จะปรากฏหนา้ต่างข้ึนมา ใหเ้ลือก ISAPI and CGI Restrictions ใหท้ าการ Allow ทั้ง 2 ช่อง 
 

 
4. คลิกท่ี elib จะปรากฏหนา้ต่างดา้นขวา ให ้ดบัเบ้ิลคลิกท่ี Hander Mappings จากนั้นในช่อง Actionsใหเ้ลือก Edit Feature 
Permissions จะปรากฏหนา้ต่างข้ึนมา ใหเ้ลือก Execute   
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กำรตรวจสอบควำมถูกต้องของระบบ 
 เน่ืองจากการท างานของระบบเป็นการท างานผา่นเครือข่ายอินเตอร์เน็ต การทดสอบสามารถท าไดโ้ดย 
1. เปิดโปรแกรม Microsoft Internet Explorer หรือ Web browser อ่ืนๆ 
2. เรียกใชโ้ปรแกรมโดยการพิมพ ์URL ดงัน้ี 

http://127.0.0.1/elib/ 
3. ถา้การติดตั้ง และการท างานของระบบถูกตอ้ง จะตอ้งปรากฏหนา้จอดงัน้ี 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
บริษัท บุ๊คโปรโมช่ันแอนด์เซอร์วสิ จ ำกดั 
เลขที่ 8ซอยกรุงเทพกรีฑำ8แยก8 แขวงหัวหมำกเขตบำงกะปิ  กรุงเทพมหำนคร  10240  

Tel: 0-2769-3888     Fax: 0-2379-5182 
 

    
   คู่มือกำรปฏิบัตงิำนระบบห้องสมดุอตัโนมตั ิ ELIB7  
 

กำรติดตั้ง Circulation (ระบบงำนยืมคืน) 
1. เร่ิมท าการติดตั้ง Circulation Setup จะปรากฏหนา้จอดงัภาพ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. คลิก OK เพ่ือเขา้สู่ขั้นตอนการติดตั้ง 

เลือก Path ท่ีตอ้งการท าการติดตั้งระบบงานยมื – คืน หากตอ้งการติดตั้งลงสู่ Default Directory ท่ีระบบจดัเตรียมไวค้ลิกปุ่ม
มุมดา้นซา้ยบน ถา้ไม่ตอ้งการติดตั้ง Path ดงักล่าวใหเ้ลือกท่ี Change Directory  
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3. เม่ือระบบท าการติดตั้งเรียบร้อยแลว้จะปรากฏไดอะลอ็กบ๊อกซ์ ดงัภาพ 
 

 
 

 

คลิก OK เป็นการส้ินสุดกระบวนการติดตั้งระบบงานยมื – คืน จากนั้นท าการ Copy File CircPlus version และ Elib.bmp ใน
แผน่ CD ลงใน Directory ท่ีไดท้ าการติดตั้งโปรแกรม  
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กำรสร้ำงฐำนข้อมูล  (Database Administrator) 
 การจดัการฐานขอ้มูลโดยใชเ้คร่ืองมือของระบบ 

กำรสร้ำงฐำนข้อมูลใหม่ 
1. เรียกเคร่ืองมือ pdbman โดย double click ท่ีไฟล ์“pdbman.exe” โดยจะอยูภ่ายใต ้directory \ELIB\Tools 

 
 

2. เลือก Menu File  Connect SQL Server 
 Server \ Instance คือ หมายเลข IP Address ของเคร่ือง Server  
 User name คือ User name ท่ีก าหนดไวใ้น SQL Server เพื่อจดัการฐานขอ้มูล ของ ELIB 
 Password คือ รหสัผา่น ของ User นั้นๆ  
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3. เลือก Menu Database  New  จะปรากฏหนา้จอ Create a new Database ดงัน้ี 

 
 

Database Key:  ช่ือฐานขอ้มูล เป็นช่ือท่ีผูดู้แลระบบใชจ้ดัการฐานขอ้มูล การตั้งช่ือ สามารถใชต้วั 
   อกัษร A - Z, 0 - 9 ความยาว ไม่เกิน 16 ตวัอกัษร ไม่ควรมีช่องวา่ง หรือเคร่ือง 
   หมายต่างๆ เช่น /, _ เป็นตน้ 
SQL Server Database: ฐานขอ้มูล SQL ท่ีตอ้งการเช่ือมโยง (การสร้างฐานขอ้มูลใน SQL สามารถ 
   ท าไดโ้ดยคลิกท่ีปุ่ม New**) 
Short name (0):  ช่ีอฐานขอ้มูล เป็นช่ือท่ีแสดงในหนา้ OPAC และ Catalog (หนา้ภาษาองักฤษ)  
   การตั้งช่ือ สามารถใชต้วั อกัษร A - Z, 0 - 9 สามารถมีช่องวา่ง หรือเคร่ืองหมายต่างๆ เช่น /, _  
   เป็นตน้  
Short name (1):  ช่ีอฐานขอ้มูล เป็นช่ือท่ีแสดงในหนา้ OPAC และ Catalog (หนา้ภาษาไทย) การ 
   ตั้งช่ือ สามารถใชต้วั อกัษร A - Z, 0 - 9 สามารถมีช่องว่าง หรือเคร่ืองหมายต่างๆ เช่น /, _ เป็น
ตน้ 
Description (0):  ค าอธิบายของฐานขอ้มูลนั้น ๆ 
Description (1):  ค าอธิบายของฐานขอ้มูลนั้น ๆ 
With Default user:  Default Username และ Password เช่น cat 
 

หมำยเหต ุ
 - ส าหรับ Database Key, Short name และ Description สามารถตั้ งเป็นช่ือเดียวกันก็ได้ เพ่ือความสะดวกใน 
การจดัการฐานขอ้มูล  
 - ในกรณีน้ี ตอ้งการสร้างฐานขอ้มูลใหม่ช่ือ “Main” และตอ้งการใหใ้นหนา้ OPAC และ CATALOG ปรากฏช่ือ
ฐานขอ้มูลเป็น Main เช่นกนั  
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ขั้นตอนการสร้างมีดงัน้ี 
1. พิมพ ์MSDE Database name :Main 
2. คลิกท่ีปุ่ม New เพื่อสร้าง SQL Database จะปรากฏหนา้จอ Create MSDE Database 

 
 

ตรวจสอบความถูกตอ้งดงัน้ี  
- MSDE Database name : เป็นช่ือเดียวกบั Database Key คือ ELIB เน่ืองจากระบบงานบริการยมืคืนจะ 

  ก าหนดค่า Default ไปท่ี database key ท่ีช่ือวา่ ELIB 
- Initial Size (MB) : ขนาดของฐานขอ้มูล  
- File growth (MB) : ถา้ฐานขอ้มูลเตม็จะใหข้ยายออกไปทีละเท่าไหร่ 
- SQL Collation Name : Thai BIN (สามารถเลือกเป็น Default ในกรณีท่ี SQL ติดตั้ง Default sort order เป็น 

  Thai BIN)  
- ในส่วนของรายละเอียดอ่ืน ๆ ไม่ตอ้งแกไ้ข เพราะระบบจะก าหนดค่าเร่ิมตน้ท่ีเหมาะสมไวแ้ลว้  

 

3. คลิกท่ีปุ่ม Create เพื่อสร้างฐานขอ้มูล 
4. รอจนกวา่จะปรากฏ Finish Message  

 
 

5. คลิกปุ่ม OK 
6. คลิกปุ่ม Close เพื่อปิดหนา้จอ 
7. ใหส้งัเกต ในส่วนของ SQL Server Database จะเป็นช่ือเดียวกบัท่ีสร้างใหม่ 
8. พิมพ ์Main Database ในช่อง short name (0) และ ฐานขอ้มูลหลกั ในช่อง short name (1) 
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9. พิมพ ์Main Database ในช่อง Description (0) และ ฐานขอ้มูลหลกั ในช่อง Description (1) 
10. เม่ือพิมพข์อ้มูลครบทุกรายการ จะมีหนา้จอดงัน้ี 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

11. ยนืยนัการสร้างฐานขอ้มูล ของระบบฯ โดยคลิกท่ีปุ่ม OK 
12.   จะปรากฏหนา้จอ แสดงสถานะและรายละเอียดของฐานขอ้มูลท่ีสร้าง รวมไปถึงค่าเร่ิมตน้ต่างๆ ท่ีระบบสร้างให ้โดยมี
รายละเอียดในแต่ละบรรทดั ดงัน้ี 

 
 

  
 
 
 
 
 
  บรรทดัที ่1 สถานะการสร้างหนา้จอบตัรรายการภาษาองักฤษ ส าหรับฐานขอ้มูล Main 
  บรรทดัที ่2 สถานะการสร้างหนา้จอบตัรรายการภาษาไทย ส าหรับฐานขอ้มูล Main 
  บรรทดัที ่3 สถานะการสร้าง Configuration File ส าหรับฐานขอ้มูล Main 
  บรรทดัที ่4 สถานะการสร้าง Parameter File ส าหรับฐานขอ้มูล Main 
  บรรทดัที ่5 สถานะการสร้าง ตารางส าหรับเก็บขอ้มูล 
  บรรทดัที ่6 สถานะการสร้าง Default account (Cataloger) 
  บรรทดัที ่7 สถานะการสร้าง elibweb account (ส าหรับจดัการฐานขอ้มูลโดยโปรแกรม elib) 
  บรรทดัที ่8 สถานะการเพ่ิมรายช่ือฐานขอ้มูลใน db list 
 

13.   คลิกปุ่ม OK ส้ินสุดกระบวนการสร้างฐานขอ้มูล 
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กำรลบฐำนข้อมูล 
1. เรียกเคร่ืองมือ pdbmanซ่ึงจดัเก็บอยูท่ี่ \ELIB\Tools\ โดย double click ท่ีไฟล ์“pdbman.exe” จะปรากฏหนา้จอดงัน้ี 

 
 

2. เลือก Menu File  Connect SQL Server 

 
 

 Server \ Instance คือ หมายเลข IP Address ของเคร่ือง Server  
 User name คือ User name ท่ีก าหนดไวใ้น SQL Server เพื่อจดัการฐานขอ้มูล ของ ELIB 
 Password คือ รหสัผา่น ของ User นั้นๆ  
 

3. เลือกฐานขอ้มูลท่ีตอ้งการลบโดยเลือกท่ี dbs  Database name เช่น ForTEST 
 



 
บริษัท บุ๊คโปรโมช่ันแอนด์เซอร์วสิ จ ำกดั 
เลขที่ 8ซอยกรุงเทพกรีฑำ8แยก8 แขวงหัวหมำกเขตบำงกะปิ  กรุงเทพมหำนคร  10240  

Tel: 0-2769-3888     Fax: 0-2379-5182 
 

    
   คู่มือกำรปฏิบัตงิำนระบบห้องสมดุอตัโนมตั ิ ELIB14  
 

4. เลือก Menu Database  Delete หรือท่ี “Delete Database” จะปรากฏหนา้จอดงัน้ี 

 
  บรรทดัที ่1 หนา้จอบตัรรายการ ของฐานขอ้มูล ForTEST 
  บรรทดัที ่2 Parameter File ของฐานขอ้มูล ForTEST 
  บรรทดัที ่3 Configuration File ของฐานขอ้มูล ForTEST 
  บรรทดัที ่4 Data Sources Name (ODBC) 
  บรรทดัที ่5 ตารางส าหรับเก็บ keyword ของฐานขอ้มูล ForTEST 
  บรรทดัที ่6 ลบตารางฐานขอ้มูล 
 

5. Click ท่ี Check box “Check All” เพ่ือเลือกส่วนประกอบของฐานทั้งหมดของฐานขอ้มูลนั้น ๆ 
6. Click ปุ่ม OK เพื่อยนืยนั 
7. Click ปุ่ม Overwrite เพื่อยนืยนัการลบ 
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8. จะปรากฏหนา้จอแสดงผลการลบฐานขอ้มูล 

 
 

9. คลิกปุ่ม OK เพ่ือท ารายการต่อไป 
**** ข้อควรระวงั:การลบฐานข้อมูล จะท าการลบข้อมูลทัง้หมดในฐานนั้นๆ ทนัท ี**** 
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กำรสร้ำง Table ส ำหรับกำรนับจ ำนวนรำยกำรในฐำนข้อมูล 
1. เรียกเค ร่ืองมือ  MSDE Console ซ่ึ งเป็น  เค ร่ืองมือ ท่ี ช่วยในการจัดการกับ  Database จะอยู่ภายใน  Directory  

\ELIB\Tools  Double Click File                           
2. จากนั้นจะปรากฏหนา้จอให ้Logon เขา้ SQL ดงัภาพ 

 

 

 Server \ Instance คือ หมายเลข IP Address ของเคร่ือง Server 
 User name  คือ User name ท่ีก าหนดไวใ้น SQL Server เพื่อจดัการฐานขอ้มูล ของ ELIB 
 Password  คือ รหสัผา่น ของ User นั้นๆ  
3. เม่ือใส่ User และ Password แลว้จะปรากฏหนา้จอการท างานในส่วนของโปรแกรม MSDE Console ดงัภาพ 

 
 
4. จากนั้นเลือกฐานขอ้มูลท่ีตอ้งการ  โดยเลือกท่ี Database กด Drop Down List ดา้นขา้ง เลือกช่ือฐาน ELIB 
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5. จากนั้นเลือก AdvancedSQL เพื่อท าการ Create Table ส าหรับสร้างตวันบัระเบียน 

 
 

6. จากนั้นจะปรากฏ Script แสดงใหเ้ห็นในช่องส่ีเหล่ียมสีขาวดา้นล่าง  
7. กดปุ่ม F5 เพื่อ Execute ค าสัง่ หรือท่ี Menu Bar กดท่ีปุ่มลูกศรสีเขียว 

 

 
 

8. เม่ือค าสัง่ถูก Execute เรียบร้อยแลว้ จะปรากฏสถานะเพ่ือแสดงการส้ินสุดการท างานดงัภาพ  

Click Here 
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Reindex  
 ขั้นตอนของการจดัเรียงค าในฐานขอ้มูลใหถู้กตอ้งกบัพจนานุกรมของระบบ 
1. เรียกเคร่ืองมือ  ElibTools  ซ่ึงเป็นเคร่ืองมือท่ีช่วยในการจดัการกบั  Database  จะอยูภ่ายใน  Directory  \ELIB\Tools  
Double Click File 
2. ปรากฎหนา้จอให ้Login เพื่อเขา้ฐานขอ้มูล 

- Database  : เลือกฐานขอ้มูลท่ีตอ้งการจะท าการ Reindex 
- User name  : ใส่ช่ือ 
- Password : ใส่รหสัผา่น 

 
 
 
 
 
 
 
 
 
 
 
3.เม่ือเขา้สู่หนา้จอการท างานของโปรแกรม ElibTools แลว้ ไปท่ี Menu Database -> Rebuild All Index 
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4. จากนั้นจะปรากฎหนา้จอให้ก าหนดช่วงระเบียนท่ีตอ้งการท าการ Reindex เม่ือก าหนดเสร็จแลว้คลิก Process เพ่ือสั่งการ
ท างาน รอจนท าการ Reindex เสร็จ คลิก close 
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กำรจัดกำรสิทธิให้กบัเจ้ำหน้ำที่  (User and Group Management) 
 

 การก าหนดรหัสเจา้หนา้ท่ีและรหัสผ่าน สามารถท าไดโ้ดยการเรียกใชเ้คร่ืองมือการจดัการระบบ ผ่าน Browser  
แต่มีขอ้แมว้า่จะตอ้งเรียกใชท่ี้เคร่ืองแม่ขา่ย หรือเคร่ือง SERVER ท่ีติดตั้งระบบหอ้งสมุดอตัโนมติัอยูเ่ท่านั้น โดยการเรียกใช้
เคร่ืองมือการจดัการระบบมีวธีิการเรียกใชง้านดงัน้ี 
 

โดยการพิมพ ์URL ตามดา้นล่าง 
รูปแบบ    http://ip_address/elib 
ตวัอยา่ง   http://127.0.0.1/elib/ 

 
เม่ือมีการเรียกใชโ้ปรแกรม จะปรากฏหนา้จอดงัน้ี 
 

 
 
ใหเ้ลือก Staff login เขา้สู่ระบบ Login ID และ Passwordจากนั้นเลือก การจดัการระบบ 
 
 
 
 
 

http://127.0.0.1/elib/
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ถา้เป็นการเร่ิมตน้ระบบใหม่ การก าหนดค่าจะตอ้งเรียงล าดบัดงัน้ี 
1. Group เป็นการก าหนดค่าเก่ียวกบักลุ่มของผูป้ฏิบติังาน 
2. Station เป็นการก าหนดค่าเก่ียวกบัเคร่ืองลูกข่าย ท่ีตอ้งการใหส้ามารถใชง้านในระบบ 
3. Users เป็นการก าหนดค่าของผูป้ฏิบติังาน ผา่น Login ID และ Password 

➢ GROUP 
กำรจดักำรกลุ่ม    
 เม่ือมีการเรียกใชเ้คร่ืองมือ SECADMIN แลว้ ส่ิงแรกท่ีจะตอ้งก าหนดค่า คือ กลุ่มของผูป้ฏิบติังาน 



 
บริษัท บุ๊คโปรโมช่ันแอนด์เซอร์วสิ จ ำกดั 
เลขที่ 8ซอยกรุงเทพกรีฑำ8แยก8 แขวงหัวหมำกเขตบำงกะปิ  กรุงเทพมหำนคร  10240  

Tel: 0-2769-3888     Fax: 0-2379-5182 
 

    
   คู่มือกำรปฏิบัตงิำนระบบห้องสมดุอตัโนมตั ิ ELIB22  
 

 
ก าหนดค่า สามารถท าไดโ้ดยขั้นตอนดงัน้ี 
1. คลิกท่ีเมนู Group จะปรากฏหนา้จอดงัน้ี 
2. คลิกท่ีเมนู New ในกรณีท่ีเร่ิมก าหนดค่าเป็นคร้ังแรก แต่ถา้ตอ้งการ Copy ค่าต่างๆ จากกลุ่มอ่ืนๆ ท่ีก าหนดไวก่้อนหนา้ 

ใหค้ลิกท่ี Copy Add ของกลุ่มนั้นๆ 
3. จะปรากฏหนา้จอดงัน้ี 
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จากหนา้จอมีรายละเอียดดงัน้ี 
 Group name : ช่ือกลุ่ม 
 Rights  : สิทธิต่างๆ ท่ีตอ้งการก าหนดใหก้บักลุ่มนั้น ๆ มีรายละเอียดดงัน้ี 
 Catalog.* : Full (New,Edit,Delete, Process,AddItem) 
 Catalog. New : สิทธิในการเพ่ิมรายการบรรณานุกรม  
 Catalog. Edit : สิทธิในการแกไ้ขรายการบรรณานุกรมในฐานขอ้มูล  
 Catalog. Delete : สิทธิในการลบรายการบรรณานุกรมในฐานขอ้มูล 
 Catalog. Process : สิทธิในการตรวจสอบขอ้มูล  
 Catalog. Item : สิทธิในการเช่ือมโยงรายการตวัเล่ม หรือบาร์โคด้ (Add Item) 
 Catalog.BufferEdit : สิทธิในการแกไ้ขรายการบรรณานุกรมในฐานขอ้มูลใน Buffer 
 Catalog.BufferProcess : สิทธิในการตรวจสอบขอ้มูล ใน Buffer 
 Delete Item : สิทธิในการลบตวัเล่มหนงัสือ 
 Circulation : สิทธิในการยมืคืนผา่นเวบ็ (web circulation) 
 Cir.Account : สิทธิในการรับจ่ายและจดัการค่าปรับ (Payment) 
 Cir.Policy : สิทธิในการปรับนโยบายหอ้งสมุด 
 Inventory : สิทธิในการเขา้ใชร้ะบบตรวจเช็คทรัพยากร 
 Set Patron’s Password : สิทธิในการแกไ้ขรหสัผา่นของสมาชิก 
 Manage Q : สิทธิในการจดัล าดบัการจองหนงัสือของสมาชิก 
 Staff Hold : สิทธิในการจองหนงัสือใหส้มาชิก 
 File Transfer : สิทธิในการถ่ายโอนขอ้มูลระหวา่งแม่ข่ายและลูกข่าย 
 System Admin : สิทธิในการเขา้ถึงฟังกช์ัน่อ่ืนๆของผูดู้แลระบบ 
 Location : สถานท่ีหรือสาขาในการท างานของหอ้งสมุด 
หมำยเหต ุ
 สิทธิอ่ืนๆ ท่ีไม่ไดก้ล่าวถึง แต่ปรากฏอยู่ในหน้าจอ หมายถึงไม่ได้มีใช้ในระบบน้ี หรือ ไม่ได้ก าหนดค่าจาก
หนา้จอน้ี  
 

4. คลิกปุ่ม Submit เพื่อบนัทึกขอ้มูล 
5. ถา้ตอ้งการจะดูวา่กลุ่มท่ีก าหนดไดมี้การบนัทึกแลว้หรือไม่ สามารถดูไดโ้ดยการคลิกท่ีเมนู List 
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การลบกลุ่ม 

 ในกรณีท่ีมีสมาชิกอยูภ่ายในกลุ่มใหท้ าการลบสมาชิกในกลุ่มๆนั้นก่อน 
1. เรียกใชเ้คร่ืองมือ SECADMIN  
2. คลิกท่ีเมนู Group จะปรากฏหนา้จอดงัน้ี 
3. คลิกท่ีเมนู Delete ของกลุ่มท่ีตอ้งการลบ 
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➢ Stations 

กำรก ำหนดสิทธิให้กบัเคร่ืองลูกข่ำย 
 การก าหนดค่า สามารถท าไดโ้ดย 

1. คลิกท่ีเมนู Stations จะปรากฏหนา้จอดงัน้ี 
 

 

2. เช่นเดียวกับการก าหนดค่ากลุ่ม คือ ในกรณีท่ีเป็นการเร่ิมต้นระบบ จะต้องเลือกจากเมนู New แต่ถ้า
ตอ้งการ Copy ค่าต่างๆ จากเคร่ืองท่ีมีอยูแ่ลว้ สามารถเลือกไดจ้ากเมนู Copy Add 

3. จะปรากฏหนา้จอดงัน้ี 
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จากหนา้จอ มีรายละเอียดดงัน้ี 
 ID  : ล าดบัท่ีของเคร่ืองลูกข่าย ระบบจะก าหนดใหอ้ตัโนมติั 
 Name  : ช่ือเคร่ืองลูกข่าย 
 Location : สถานท่ี ท่ีติดตั้งเคร่ืองลูกข่าย 
 Allow  : สิทธิในการใชง้านของเคร่ืองลูกข่ายนั้น ๆ รายละเอียดของสิทธิท่ีใชมี้ดงัน้ี 
 Catalog.* : Full (New,Edit,Delete, Process,AddItem) 
 Catalog. New : สิทธิในการเพ่ิมรายการบรรณานุกรม  
 Catalog. Edit : สิทธิในการแกไ้ขรายการบรรณานุกรมในฐานขอ้มูล  
 Catalog. Delete : สิทธิในการลบรายการบรรณานุกรมในฐานขอ้มูล 
 Catalog. Process : สิทธิในการตรวจสอบขอ้มูล  
 Catalog. Item : สิทธิในการเช่ือมโยงรายการตวัเล่ม หรือบาร์โคด้ (Add Item) 
 Catalog.BufferEdit : สิทธิในการแกไ้ขรายการบรรณานุกรมในฐานขอ้มูลใน Buffer 
 Catalog.BufferProcess : สิทธิในการตรวจสอบขอ้มูล ใน Buffer 
 Delete Item : สิทธิในการลบตวัเล่มหนงัสือ 
 Circulation : สิทธิในการยมืคืนผา่นเวบ็ (web circulation) 
 Cir.Account : สิทธิในการรับจ่ายและจดัการค่าปรับ (Payment) 
 Cir.Policy : สิทธิในการปรับนโยบายหอ้งสมุด 
 Inventory : สิทธิในการเขา้ใชร้ะบบตรวจเช็คทรัพยากร 
 Set Patron’s Password : สิทธิในการแกไ้ขรหสัผา่นของสมาชิก 
 Manage Q : สิทธิในการจดัล าดบัการจองหนงัสือของสมาชิก 
 Staff Hold : สิทธิในการจองหนงัสือใหส้มาชิก 
 File Transfer : สิทธิในการถ่ายโอนขอ้มูลระหวา่งแม่ข่ายและลูกข่าย 
 System Admin : สิทธิในการเขา้ถึงฟังกช์ัน่อ่ืนๆของผูดู้แลระบบ 
 Location : สถานท่ีหรือสาขาในการท างานของหอ้งสมุด 
หมำยเหต ุ
  สิทธิอ่ืนๆ ท่ีไม่ไดก้ล่าวถึง แต่ปรากฏอยู่ในหน้าจอ หมายถึงไม่ได้มีใช้ในระบบน้ี หรือ ไม่ได้ก าหนดค่าจาก
หนา้จอน้ี 
 IP : หมายเลข IP Address ของเคร่ืองลูกข่าย 
 Mask : Subnet Mark ของระบบ (255.255.255.255) 

4. คลิกปุ่ม Submit เพ่ือบนัทึกค่า 
5. ถา้ตอ้งการตรวจสอบวา่มีการบนัทึกค่าแลว้หรือไม่ สามารถดูไดจ้ากเมนู List 
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กำรยกเลกิสิทธิของเคร่ืองลูกข่ำย 
 การยกเลิกสิทธิสามารถท าไดโ้ดย 
1. คลิกท่ีเมนู Stations จะปรากฏหนา้จอดงัน้ี 
2. คลิกท่ีเมนู Delete ของเคร่ืองท่ีตอ้งการ 
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➢ Users 
 

กำรก ำหนดสิทธิให้กบัเจ้ำหน้ำที่ 

 การก าหนดค่า สามารถท าไดโ้ดย 
1. คลิกท่ีเมนู Users จะปรากฏหนา้จอดงัน้ี 
2. เช่นเดียวกบัการก าหนดค่ากลุ่ม คือ ในกรณีท่ีเป็นการเร่ิมตน้ระบบ จะตอ้งเลือกจากเมนู New แต่ถา้ตอ้งการ Copy ค่า

ต่างๆ จากเคร่ืองท่ีมีอยูแ่ลว้ สามารถเลือกไดจ้ากเมนู Copy Add 
3. จะปรากฏหนา้จอดงัน้ี 
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จากหนา้จอ มีรายละเอียดดงัน้ี 
 Login name : รหสั การตั้งค่าคือ a-z, 0-9 ความยาวไม่เกิน 16 ตวัอกัษร 
 Password : รหสัผา่น ความยาวไม่ควรนอ้ยกวา่ 4 ตวัอกัษร 
 Retype password : ยนืยนัรหสัผา่น พิมพใ์หเ้หมือนกบั Password 
 Initial  : ตวัยอ่ 
 UC-Loc : รหสั หรือ ช่ือหอ้งสมุด 
 Email  : Email address ของเจา้ของรหสั 
 Full Name : ช่ือเตม็ ของเจา้ของรหสั  
 Base Location : สถานท่ี 
 Group  : กลุ่มท่ีสงักดั (เลือกไดม้ากกวา่ 1 ขอ้) 
 Station : เคร่ืองท่ีท างาน (เลือกไดม้ากกวา่ 1 เคร่ือง) 
4. คลิกปุ่ม Submit เพ่ือบนัทึกค่า 
5. ถา้ตอ้งการตรวจสอบวา่มีการบนัทึกค่าแลว้หรือไม่ สามารถดูไดจ้ากเมนู List 

กำรยกเลกิสิทธิของเจ้ำหน้ำที ่
 การยกเลิกสิทธิสามารถท าไดโ้ดย 
1. คลิกท่ีเมนู Users จะปรากฏหนา้จอดงัน้ี 
2. คลิกท่ีเมนู Delete ของ User ท่ีตอ้งการ 

 
 
 
 



 
บริษัท บุ๊คโปรโมช่ันแอนด์เซอร์วสิ จ ำกดั 
เลขที่ 8ซอยกรุงเทพกรีฑำ8แยก8 แขวงหัวหมำกเขตบำงกะปิ  กรุงเทพมหำนคร  10240  

Tel: 0-2769-3888     Fax: 0-2379-5182 
 

    
   คู่มือกำรปฏิบัตงิำนระบบห้องสมดุอตัโนมตั ิ ELIB30  
 

กำรก ำหนดรูปแบบกำรลงรำยกำร 
(Catalog Form or Worksheet Setup) 

 

 Catalog Form หรือ Work Sheet จะเป็นหน้าจอท่ีใช้ในการลงรายการ (Data Entry) การลงรายการจะมี 2 แบบ  
คือ MARC และ Non-MARC ส่วนการก าหนดรูปแบบ สามารถก าหนดแยกยอ่ยตามทรัพยากร ท่ีจะลงรายการ เช่น หนงัสือ, 
วารสาร, เทป ฯลฯ 
 การก าหนดรูปแบบการลงรายการ สามารถท าได้โดยก าหนดค่าจากไฟล์ “.mrc” (ในกรณีท่ีลงรายการแบบ 
MARC) และ “.elf” (ในกรณีท่ีลงรายการแบบ Non-MARC) ซ่ึงอยูใ่น Folder “\ELIB\elib\catform” 
 การตั้งช่ือไฟลค์วรจะตั้งช่ือตามทรัพยากรท่ีตอ้งการลงรายการเช่น Book, Serial, Journal Index ตวัอยา่งเช่น  
book.mrc, book.elf, serial.mrc, serial.elf ในกรณีท่ีต้องการลงรายการมากกว่า 1 แบบ คือตอ้งการลงรายการทั้ งในแบบ 
MARC และ Non-MARC จะตอ้งสร้างไฟล์ทั้ งสองแบบ เช่นตอ้งการลงรายการหนังสือทั้ง 2 แบบ จะตอ้งสร้างไฟล์ ช่ือ 
book.mrc (ส าหรับลงรายการแบบ MARC), book.elf (ส าหรับลงรายการแบบ Non-MARC) 
 เม่ือสร้างไฟลท่ี์เก็บรูปแบบการลงรายการแลว้ จะตอ้งน าช่ือไฟลม์ารวมกนัเพ่ือบอกให้ระบบรู้ว่ามีไฟล์ใดบา้ง  
ท่ีเป็นไฟล์ท่ีใชส้ าหรับลงรายการ สามารถก าหนดได้โดยสร้างไฟล์ช่ือ “control.sys”อยู่ภายใน Folder เดียวกบัไฟล์ท่ีใช ้
ลงรายการ คือ “\ELIB\elib\catform\”ภายในไฟลจ์ะมีรูปแบบดงัน้ี 
 

[default] 
book.elf=nonmarc books 
book.mrc=marc books 
serial.elf=nonmarc serials 
serial.mrc=marc serials 

 

มีรูปแบบดงัน้ี 
 ช่ือไฟล.์elf = Non-MARC (ช่ือไฟล)์  เช่น book.elf  = Non-MARC (book) 
 ช่ือไฟล.์mrc = MARC (ช่ือไฟล)์  เช่น book.mrc  = MARC (book) 

 ถา้ตอ้งการใหส้ามารถท าการ Copy record ได ้ใหเ้พ่ิม “_” ส่วนช่ือจะเป็นอะไรก็ได ้

[Default] 
book.elf=nonmarc books 
book.mrc=marc books 
serial.elf=nonmarc serials 
serial.mrc=marc serials 
_=copy&nbsp;record 
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กำรก ำหนดรูปแบบกำรลงรำยกำรแบบ MARC 
 การปรับแต่งหรือการแกไ้ขจะท าโดยใช ้Text Editor ทัว่ๆ ไป เช่น Notepad มีขั้นตอนดงัน้ี 
1. เปิดไฟล ์“book.mrc”  
2. ลกัษณะของขอ้มูลภายในจะเป็นดงัน้ี 

[fixed]                                            →  Fixed Field  
f806=                                              →  Fixed Field 008 ต ำแหน่งท่ี 6 
f838=                                              →  Fixed Field 008 ต ำแหน่งท่ี 38 
f8date1=                                          →ปีท่ีพิมพ์ 
f8date2=                                          →ปีท่ีหยดุพิมพ์  
f8lang=                                           →ภำษำ 
f8pubplace=                                     →เมืองท่ีพิมพ์ 
L05=n                                             → Leader ต ำแหน่งท่ี 5 
L06=a                                             → Leader ต ำแหน่งท่ี 6 
L07=m                                             → Leader ต ำแหน่งท่ี 7 
 

[default] 
020=##                                             → Tag 020 
100=##                                             → Tag 100 
245=##                                             → Tag 245 
260=##                                             → Tag 260 
300=##                                             → Tag 300 
650=##                                             → Tag 650 
949=##BPS Library                         → Tag 949 

 

 จากตวัอยา่ง ขอ้มูลท่ีปรากฏจะแบ่งออกเป็น 2 ส่วน แต่ละส่วนจะแยกดว้ย เคร่ืองหมายวงเลบ็ ไดแ้ก่ 
  [Fixed] คือ ส่วนของ Fixed Field รายละเอียดดูไดจ้าก USMARC Format 
  [Default] คือ Tag ท่ีตอ้งการใชง้าน และค่าเร่ิมตน้ต่างๆ เป็นส่วนท่ีจะตอ้งมีการแกไ้ข  
    ลกัษณะของขอ้มูล จะมีรูปแบบดงัน้ี 
   เลข Tag = อนิดเิคเตอร์ + ค่ำเร่ิมต้น  เช่น 
   949 = --          BPS 
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การแกไ้ข หรือก าหนดค่าในส่วนของ Default จะข้ึนอยูก่บับรรณารักษ ์วา่ตอ้งการอะไรบา้ง เช่น ถา้บรรณารักษ ์
ก าหนดรายละเอียดท่ีตอ้งการดงัน้ี 

1. Tag ท่ีตอ้งการใชง้าน คือ 020, 100, 245, 260, 300, 650 และ 949  
2. ตอ้งการค่าเร่ิมตน้ BPS ท่ี Tag 949  
3. ตอ้งการอินดิเคเตอร์ 02 ท่ี Tag 650  

ลกัษณะของขอ้มูลท่ีไดจ้ะเป็นดงัน้ี  
[fixed] 
f806= 
f838= 
f8date1= 
f8date2= 
f8lang=   
f8pubplace= 
L05=n   
L06=a   
L07=m  
 

[default] 
020=## 
100=## 
245=## 
260=## 
300=## 
650=02 
949=##BPS 
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กำรก ำหนดรูปแบบกำรลงรำยกำรแบบ Non - MARC 
 การปรับแต่งหรือการแกไ้ขจะท าโดยใช ้Text Editor ทัว่ ๆ ไป เช่น Notepad มีขั้นตอนดงัน้ี 
1. เปิดไฟล ์ "books.elf"  
2. ลกัษณะของขอ้มูลภายในจะเป็นดงัน้ี 

[fixed] 
material=0                                     →ประเภทของทรัพยำกร(0-6) ดูจากหมายเหตุ 
f806=                                              → Fixed Field 008 ต ำแหน่งท่ี 6 
f838=                                              →  Fixed Field 008 ต ำแหน่งท่ี 38 
f8date1=                                         →ปีท่ีพิมพ์ 
f8date2=                                         →ปีท่ีหยดุพิมพ์  
f8lang=                                           →ภำษำ 
f8pubplace=                                   →เมืองท่ีพิมพ์ 
L05=n                                             → Leader ต ำแหน่งท่ี 5 
 

[tags] 
020=ISBN 
082=Call Number 
100=Author 
110=Corp. Author 
245=Title 
260a=Published Place 
260b=Publisher Name 
260c=Published Year 
300=Physical 
500=Note 
650=Subject 
700=Added Author 
856=Object Name 
949=Location code 
 

; default: initial record 
[default] 
020= 
082= 
100= 
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245= 
260a= 
260b= 
260c= 
300= 
650= 
949=BPS 

 

หมำยเหต ุ
 **ประเภทของทรัพยากร: 0-Books, 1-ComputerFiles, 2-Maps, 3-Recording, 4-V al, 5-Mixed, 6-Serials 
 

 จากตวัอยา่ง ขอ้มูลท่ีปรากฏจะแบ่งออกเป็น 3 ส่วน แต่ละส่วนจะแยกดว้ย เคร่ืองหมายวงเลบ็ ไดแ้ก่ 
  [Fixed]  คือ ส่วนของ Fixed Field รายละเอียดดูไดจ้าก USMARC Format 
  [Tags] คือ ของ การ map หมายเลข tag กบัช่ือ tag ท่ีตอ้งการใหแ้สดงในหนา้ลงรายการ 

[Default] คือ Tag ท่ีตอ้งการใชง้าน และค่าเร่ิมตน้ต่าง ๆ เป็นส่วนท่ีจะตอ้งมีการแกไ้ข  
   ลกัษณะของขอ้มูล จะมีรูปแบบดงัน้ี 
  เลข Tag = ค่ำเร่ิมต้น  เช่น 
  949 = BPS 
 

 การแก้ไข หรือก าหนดค่าในส่วนของค่าเร่ิมต้น จะข้ึนอยู่กับบรรณารักษ์ ว่าต้องการอะไรบ้าง เช่น ถ้า
บรรณารักษ ์ก าหนดรายละเอียดท่ีตอ้งการดงัน้ี 

1. Tag ท่ีตอ้งการใชง้าน คือ 020, 100, 245, 260, 300, 650 และ 949  
2. ตอ้งการค่าเร่ิมตน้ BPS ท่ี Tag 949 

 

ลกัษณะของขอ้มูลท่ีไดก็้จะเป็นดงัน้ี  
[fixed] 
material=0 
f806= 
f838= 
f8date1= 
f8date2= 
f8lang= 
f8pubplace= 
L05=n 
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[tags] 
020=ISBN 
082=Call Number 
100=Author 
110=Corp. Author 
245=Title 
260a=Published Place 
260b=Publisher Name 
260c=Published Year 
300=Physical 
500=Note 
650=Subject 
700=Added Author 
856=Object Name 
949=Location code 
 

[default] 
020= 
100= 
245= 
260a= 
260b= 
260c= 
300= 
650= 
949=BPS 

 

หมำยเหต ุ
 ** สงัเกตุวา่รูปแบบการลงรายการแบบ Non-MARC จะไม่มีอินดิเคเตอร์ และสามารถก าหนดไดถึ้ง Subfield 
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กำรจัดกำรและกำรเช่ือมโยงส่ือผสม  (Multimedia Setup) 
กำรติดตั้งมัลติมีเดีย 
 มีขั้นตอนดงัน้ี 
1. สร้างโฟลเดอร์ ส าหรับเก็บไฟล ์มลัติมีเดีย 
2. คลิกท่ีปุ่ม Start  เล่ือนตวัช้ีไปท่ี Programs จะมีเมนูเพ่ิมเติมปรากฏทางดา้นขวา เลือกตวัช้ีต่อไปท่ี  Administrative 

Tools จะมีเมนูเพ่ิมเติมปรากฏทางดา้นขวา คลิกท่ี Internet Information Services (IIS) Manager  
3. จากหนา้จอทางดา้นซา้ย, คลิกปุ่มขวาของ mouse ท่ี Default Web Site  เลือกAdd Virtual Directory ตามรูปดา้นล่าง 
 
 
 
 
 
 
 
 
 
 
 
 
4.     จะปรากฏหนา้จอ Add Virtual Directory  ในช่อง Alias ใหพ้ิมพ ์multim และใหเ้ลือก Path ท่ีตอ้งการเช่ือมโยง ( คือ 
Path ท่ีไดติ้ดตั้งโปรแกรม ELIB เช่น “D:\multim” ) โดยการคลิกปุ่ม  Browse เพื่อเลือก Path ท่ีตอ้งการ คลิก OK 
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5.       ติดตั้ง “$Url01”ใหต้รงกบั Server nameหรือ IP Addressของ Multimedia Serverมีขั้นตอนดงัน้ี 
- ใช ้Notepad เปิด File ช่ือ “cfg.ini”ซ่ึงอยูใ่น Folder “ELIB\elib\cfg-mdb” 
- หาค าว่า [$Url01]แก้ไขหลัง v1เป็น“IP Addressหรือ Server nameของ Multimedia Server”เช่น 

http://www.book.co.thหรือ http://203.144.248.25 
- บนัทึกค่า แลว้ออกจากโปรแกรม 
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กำรน ำข้อมูลเข้ำสู่ระบบ   (Import) 
 

 การน าขอ้มูลเขา้สู่ระบบห้องสมุดอตัโนมติั “ELIB” สามารถท าได ้2 วิธี คือ น าเขา้โดยการบนัทึกผ่าน Catalog 
Module และ โดยการ Upload ผา่นเคร่ืองมือของระบบ ความแตกต่างระหวา่ง การบนัทึกเขา้และ การ Upload คือ 
 

กำรบันทกึผ่ำน Cataloging Module  
1. น าเขา้ขอ้มูลไดค้ร้ังละ 1 รายการ  
2. สามารถเช่ือมโยงรายการตวัเล่มไดท้นัที 
3. สามารถควบคุมการลงรายการ ในส่วนของช่ือผูแ้ต่ง และหวัเร่ือง โดยใช ้Authority Control file  

 

กำร Upload ผ่ำนเคร่ืองมือของระบบ 
1. สามารถน าเขา้ขอ้มูลซ่ึงไดจ้ากระบบอ่ืนๆ แต่อยูใ่นรูปแบบ US-MARC 
2. น าเขา้ขอ้มูลไดม้ากกวา่ 1 รายการในการ Upload แต่ละคร้ัง 

 

 ในบทน้ีจะกล่าวถึงการน าเข้าข้อมูลแบบ การ Upload ส่วนการน าเข้าแบบ บันทึกผ่าน Cataloging Module  
จะกล่าวถึงใน คู่มือการใชง้านโปรแกรม  
 

ขั้นตอนกำร Upload ข้อมูล 
 

 เคร่ืองมือท่ีใชใ้นการน าขอ้มูลเขา้ระบบ คือ dbload.exeโดยมีขั้นตอนการท างานดงัน้ี 
1. เรียกใชง้านโปรแกรมคลิกท่ี dbload.exeจาก Folder “\ELIB\Tools” 
2. เม่ือเรียกโปรแกรม จะปรากฏหนา้จอดงัน้ี 
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จากรูป จะแบ่งออกเป็น 6 ส่วนดงัน้ี 
 2.1 Input fileคือ ส่วนของไฟล ์ตน้ฉบบั ท่ีตอ้งการ load เขา้ระบบ ประกอบดว้ย 

❑ Name :ช่ือไฟล์ ท่ีต้องการ สามารถเลือกไฟล์ได้โดยคลิกท่ีปุ่ม Browse และคลิกท่ีปุ่ม Fetch เพื่อดู
ตวัอยา่งขอ้มูลภายในไฟล ์วา่เป็นขอ้มูลท่ีตอ้งการหรือไม่ 

❑ Type :ประเภทของขอ้มูล มีอยู ่3 ประเภท คือ Elib Text ,PK Text และ ISO2709 
 

ตวัอยา่งขอ้มูลท่ีเป็น ELIB TEXT 

008 ## 020227s19890000nyua     b    101 0 eng   
010 ## 89006646  
020 ## 0872626962  
050 0# TE5\b.E54 1989  
245 00 engineering 21st century highways: \bproceedings of a conference   
260 ## New York, N.Y.:\bAmerican Society of Civil Engineers, \cc1989  
300 ## x, 415 p.:\Bill. ; \c22 cm  
504 ## Includes bibliographies and indexes  
650 0# Highway engineering\xCongresses  
650 0# Highway engineering\zUnited States\xCongresses  
700 10 Hall, Thomas A  
710 10 California.\bDept. Of Transportation  
710 10 United States.\bFederal Highway Administration  
710 20 American Society of Civil Engineers.\bHighway Division 
;1 

 
ตวัอยา่งขอ้มูลท่ีเป็น PK TEXT 

Record #1 
       1 110   World Health Organization, Geneva 
       1 245   Women's health and human rights 
       1 260   Geneva\bWHO\c1994 
       1 300   62 p. 
       1 082   WHO 001 
       1 650   WOMEN 
Record #2 
       2 110   World Health Organization 
       2 245   The health of young  people : A Challenge and promise 
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       2 260   Geneva\bWHO\c1993 
       2 300   109 p. 
       2 082   WHO 002 
       2 650   HEALTH 

 
ตวัอยา่งขอ้มูลท่ีเป็น US-MARC 

00518nam  2200205 a 
45000010010000000080041000100160010000510200018000610410008000790820019000871000021001061000
02200127245002600149260005400175300002100229650001700250900001500267910002100282949000900303
-0000-0065-020408 00000000                         -a06297-a974-588-228-3-atha-a11.02.01 ม456จ-aมาโนช ห ล่อ
ตระกูล-aปราโมทย ์สุคนิชย-์aจิตเวชศาสตร์รามาธิบดี-aกรุงเทพ ฯbคณะแพทยศาสตร์ โรงพยาบาลรามาธิบดีc2539--
a478 ห น้ า ; 21 ซ ม .-aจิ ต เว ช ศ าส ต ร์ -a250.00 บ าท -a2 พ ฤ ศ จิ ก ายน  2543-aDOHL-00477nam  2200193 a 
45000010010000000080041000100160010000510200018000610410008000791000023000872450031001102500
02000141260003500161300001300196650003000209650002000239900001500259949000900274-0000-
0066-020408 00000000                         -a06309-a974-519-752-1-atha-aนวลศิริ เปาโรหิตย-์aศิลปะการสร้างวินัย
ชนะใจลูก-aพิมพค์ร้ังท่ี 3-aกรุงเทพฯbตน้ออ้ แกรมม่ีc2539-a183 หน้า-aเด็ก-การบริบาลและสุขวิทยา-aพฒันาการ
ของเด็ก-a115.00 บาท-aDOHL-00413nam  2200181 a 

 

❑ Subfield character :เคร่ืองหมายของ Subfield ท่ีปรากฏอยู่ในข้อมูล ท่ีต้องการน าเข้าระบบ มีอยู ่ 
4 เคร่ืองหมายคือ ASCII :92 (\), ASCII : 36 ($), ASCII : 124 (|) และ ASCII : 31 ( ) 

2.2 SCN Action 
❑ Remove Old 035 : ลบขอ้มูลรายการ 035 เดิม 
❑ Compose New 035 : สร้างขอ้มูลรายการ 035 ใหใ้หม่ 
❑ Preserve 001 : ลงรายการท่ีอพัโหลดเป็นรายการใหม่ 
❑ Overwrite if same 001 : ลงขอ้มูลทบัรายการเดิมถา้ มีเลข 001 เดิมก่อนอยูแ่ลว้ 

 2.3 Output คือ ส่วนของปลายทาง ไดแ้ก่ฐานขอ้มูลท่ีตอ้งการน าขอ้มูลเขา้ ประกอบดว้ย 
❑ Database name : ช่ือฐานขอ้มูล เช่น main 
❑ Default leader : ประเภทของ Material ท่ีตอ้งการน าเขา้ระบบ เช่น  

- nam : Books 
- nas : Serials 
- nmm : Computer files 
- nem : Maps 
- ncm : Recording 
- ngm : Visual Materials 
- npm : Mixed Matirials 
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❑ Process Item tag : สร้าง tag (ตามท่ีเลือก)ใหม่เก็บขอ้มูลตวัเล่มหากในรายการนั้น ๆ มีขอ้มูลตวัเล่มอยู ่ 
❑ Process elib tag : สร้าง tag (ตามท่ีเลือก)ใหม่เก็บขอ้มูลตวัเล่มหากในรายการนั้น ๆ มีขอ้มูลตวัเล่มอยู ่
❑ Duplicate ItemNo. : ขา้ม ItemNo. ท่ีซ ้ า / เขียนทบั Overwrite ItemNo. ท่ีมีอยูเ่ดิมไปดว้ย 
❑ Process elib_tag : สร้าง tag ท่ีเก็บขอ้มูล วนัท่ีน าเขา้ 
❑ If no elib_tag, Load EntrDate from tag 008 : ในกรณีท่ีไม่มี elib_tag (998) ให้โหลดวนัท่ีน าเขา้ขอ้มูล

จาก tag 008 
❑ Enable freetext index : ท า Index ของ keyword เพื่อใชใ้นการสืบคน้แบบ Keyword 

  

 
 
 
 
 
 
 2.4 Enable Duplicate Handlerคือ การน าเขา้ขอ้มูลโดยเช็คขอ้มูลTag รายการตามตอ้งการ เพ่ือไม่ใหดึ้ง
รายการท่ีน าเขา้ใหม่ไปซ ้ ากบัในระบบ   

❑  Tags to check for duplicate : กรอก Tag ท่ีตอ้งการใหร้ะบบเช็คขอ้มูลรายการซ ้ า 
❑ Duplicate bib record : ตั้งค่าใหข้า้มรายการ , เขียนทบัรายการ , เก็บทั้งรายการและตวัเล่ม , ร่วมตวัเล่ม 
❑    File to store duplicate : log file ส าหรับเช็คขอ้มูลหลงัน าเขา้ 

 2.4 Log fileคือ บนัทึก Error message ต่าง ๆ ท่ีอาจจะเกิดข้ึนในขณะท่ีมีการน าขอ้มูลเขา้ระบบ  
 2.5 Message คือ หนา้ต่าง ท่ีใชแ้สดงผลการท างาน เช่น ตวัอยา่งขอ้มูลท่ีไดจ้ากการ Fetch, Error message 
ต่างๆ ท่ีเกิดข้ึนระหวา่งการท างาน หรือ รายละเอียด อ่ืนๆ ไดแ้ก่  

❑ Start at : Thu Feb 21 18:36:25 2002 
❑ Finish at : Thu Feb 21 18:38:12 2002 
❑ Elapsed:   107 seconds. 
❑ Inserted record : 412 
❑ Performance : 13862 bib/hour 

 2.6 Statusคือ สถานะ การท างาน ประกอบดว้ย 
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❑ File size (Lines) :จ านวนบรรทดัทั้งหมด 
❑ Current line :บรรทดัปัจจุบนั 
❑ Added record counter :จ านวนรายการท่ีไดมี้การบนัทึกเขา้ระบบแลว้ 
❑ Error record counter :จ านวนรายการท่ีไม่สามารถบนัทึกเขา้ระบบ 
❑ Performance (bib/hour) :จ านวนรายการ / ชัว่โมง 

3. คลิกปุ่ม Process เพ่ือเร่ิมตน้การน าขอ้มูลเขา้ระบบ 
4. การน าขอ้มูลเขา้ระบบจะสมบูรณ์ เม่ือปุ่ม Close Enable หรือ  Current line = File size (line) 
5. คลิกปุ่ม Close เพ่ือส้ินสุดการท างาน 
 



 
บริษัท บุ๊คโปรโมช่ันแอนด์เซอร์วสิ จ ำกดั 
เลขที่ 8ซอยกรุงเทพกรีฑำ8แยก8 แขวงหัวหมำกเขตบำงกะปิ  กรุงเทพมหำนคร  10240  

Tel: 0-2769-3888     Fax: 0-2379-5182 
 

    
   คู่มือกำรปฏิบัตงิำนระบบห้องสมดุอตัโนมตั ิ ELIB43  
 

กำรน ำข้อมูลออกจำกระบบ  (Export) 
 

 การน าขอ้มูลออกจากระบบ จะสามารถท าไดโ้ดยการเรียกใชเ้คร่ืองมือ “Export.exe” ผ่าน ไอคอน Export หรือ 
เรียกใชโ้ปรแกรมโดยตรง ไดจ้าก Folder “\ELIB\Tools\” ซ่ึงมีขั้นตอนการใชง้านดงัน้ี 

ขัน้ตอนกำรใช้งำน 
1. เรียกใชเ้คร่ืองมือ โดยคลิกท่ีไอคอน Export 
2. ปรากฏหนา้จอให ้logon เขา้ฐานขอ้มูล เลือกฐานขอ้มูลท่ีตอ้งการ ใส่ username และ password 

 

 
 

3. จะปรากฏหนา้จอดงัน้ี 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
จากรูป สามารถแบ่งออกเป็น 3 ส่วน ไดแัก่ Destination, Source และ Status โดยมีรายละเอียดดงัน้ี 
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3.1 Destination 
❑ File name : ช่ือไฟล ์และสถานท่ีจดัเก็บไฟล ์เพ่ือความสะดวก สามารถคลิกท่ีปุ่ม … เพื่อเลือก

สถานท่ีจดัเก็บได ้ การตั้งช่ือไฟลค์วรตั้งช่ือใหส่ื้อถึงขอ้มูลภายใน 
❑ File Type :ประเภทของขอ้มูลท่ีตอ้งการน าออกมา มีอยู่ 2 ประเภทคือ ELIB Text และ US-

MARC 
❑ Encoding : รูปแบบของการเขา้รหสัภาษา 

ตวัอยา่งขอ้มูลท่ีเป็น ELIB TEXT 

008 ## 020227s19890000nyua     b    101 0 eng   
010 ## 89006646  
020 ## 0872626962  
050 0# TE5\b.E54 1989  
245 00 engineering 21st century highways: \bproceedings of a conference   
260 ## New York, N.Y.:\bAmerican Society of Civil Engineers, \cc1989  
300 ## x, 415 p.:\Bill. ; \c22 cm  
504 ## Includes bibliographies and indexes  
650 0# Highway engineering\xCongresses  
650 0# Highway engineering\zUnited States\xCongresses  
700 10 Hall, Thomas A  
710 10 California.\bDept. Of Transportation  
710 10 United States.\bFederal Highway Administration  
710 20 American Society of Civil Engineers.\bHighway Division 
;1 

ตวัอยา่งขอ้มูลท่ีเป็น US-MARC 

00518nam  2200205 a 
45000010010000000080041000100160010000510200018000610410008000790820019000871
00002100106100002200127245002600149260005400175300002100229650001700250900001
500267910002100282949000900303-0000-0065-020408 00000000                         -a06297--
a974-588-228-3-atha-a11.02.01 ม456จ-aมาโนช หล่อตระกลู-aปราโมทย ์สุคนิชย-์aจิตเวชศาสตร์
รามาธิบดี-aกรุงเทพ ฯbคณะแพทยศาสตร์ โรงพยาบาลรามาธิบดีc2539-a478 หน้า; 21 ซม.-aจิต
เ ว ช ศ า ส ต ร์ -a250.00 บ า ท -a2 พ ฤ ศ จิ ก า ย น  2543-aDOHL-00477nam  2200193 a 
45000010010000000080041000100160010000510200018000610410008000791000023000872
45003100110250002000141260003500161300001300196650003000209650002000239900001
500259949000900274-0000-0066-020408 00000000                         -a06309-a974-519-752-1--
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atha-aนวลศิริ เปาโรหิตย์-aศิลปะการสร้างวินัยชนะใจลูก-aพิมพ์คร้ังท่ี 3-aกรุงเทพฯbต้นอ้อ 
แกรมม่ีc2539-a183 หน้า-aเด็ก-การบริบาลและสุขวิทยา-aพัฒนาการของเด็ก-a115.00 บาท--
aDOHL-00413nam  2200181 a 

3.2 Source  
❑ Database : ช่ือฐานขอ้มูล ท่ีตอ้งการน าขอ้มูลออก 
❑ Start FromBibID : BibID เร่ิมตน้ท่ีตอ้งการน าขอ้มูลออก 
❑ Stop at BibID : BibID สุดทา้ยท่ีตอ้งการน าขอ้มูลออก 
❑ Include elib tag(998) : สร้าง tag (ตามท่ีเลือก)ใหม่เก็บขอ้มูลตวัเล่มหากในรายการนั้น ๆ มี

ขอ้มูลตวัเล่มอยู ่
❑ Include item tag :สร้าง tag (ตามท่ีเลือก)ใหม่เก็บขอ้มูลตวัเล่มหากในรายการนั้น ๆ มีขอ้มูล

ตวัเล่มอยู ่
3.3 Statusคือสถานะการท างาน 

❑ Current BibID : BibID ปัจจุบนัท่ีก าลงัน าขอ้มูลออก 
4. เม่ือก าหนดค่าเร่ิมตน้ท่ีตอ้งการแลว้ คลิกปุ่ม Export เพ่ือเร่ิมน าขอ้มูลออก 
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กำรก ำหนดค่ำเร่ิมต้นให้กบัระบบ(Configuration Setup) 
 เม่ือท าการสร้างฐานขอ้มูลในทุกๆ คร้ัง ระบบจะท าการสร้างค่าเร่ิมตน้ใหแ้ต่ละฐานขอ้มูล ซ่ึงจะอยูใ่นส่วนของ 
\ELIB\elib\config\%db%.ini และ \ELIB\elib\config\%db%.prm  
%db%.ini จะเป็นส่วนท่ีก าหนดรูปแบบในการแสดงผล มีรายละเอียดขอ้มูลในไฟลด์งัน้ี 

;%db%.ini 
; content may change any time 
 

[default] 
catmode=marc 
catform=default.mrc 
; screen=crd/mrc/cmenu 
screen=crd           →ก าหนดรูปแบบการแสดงผลในหนา้จอ OPAC 

[system] 
; duplicatemode=2 -- 0:discard, 1:merge949, 2:duplicate. →ก าหนดการน าเขา้ขอ้มูลท่ีมี isbn / issn เหมือนกนัวา่ใหท้ า 
                อยา่งไร 
; duplicatelog=1 -- 0:disable, 1:enable →ก าหนดใหเ้ก็บ log file ในกรณีท่ีมีขอ้มูลซ ้ ากนั เลือก 0 ไม่เก็บ เลือก 1 เก็บ 
duplicatelog=0  
; ForCirculation=1 -- enable item level menu.  →ก าหนดใหมี้การเช่ือมโยงกบัระบบงานยมืคืน 
ForCirculation=1  
; keep -1:hide, 0:disable, 1:enable  →ก าหนดใหท้ าการเก็บขอ้มูลลงใน buffer ก่อน เพ่ือรอตรวจสอบ 
keep=-1    
; cat_next_prev=0, 1:display next/prev link when finish edit bib  →ก าหนดใหแ้กไ้ขรายการในระเบียนก่อนหนา้ / ถดัไป 
cat_next_prev=1            ได ้    
 

; to display 856 image in card screen   →ก าหนดขนาดของรูปภาพท่ีตอ้งการแสดงใน tag856 
856Width=60 
856Height=60 
 

; if import EntrDate from F08, YY>=century19 would be 19YY, otherwise 20YY 
;century19=50 
ก าหนดใหท้ าการดึง Date 1 ใน fix field 008 จาก tag และ sub field ตามก าหนดดา้นล่าง 
date1.1=260c 
date1.2=82d 
 

[ft]     →ก าหนดรูปแบบการแสดงผลการสืบคน้ในแบบ Keyword Search 
word_in_phrase=1 
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[SpineMap] → ก าหนดรูปแบบการแสดงรายงานสนัหนงัสือ 
v1=V. 
v2=NO. 
v3=ล. 
r1=REF 
r2=THE 
r3=GP 
r4=อ 
r5=ว 
r6=นว 
cno0="  C." 
cno1="  ฉ." 
caltags=50,60,82,96,99 
LCTag=50 
%db%.prm จะเป็นส่วนท่ีก าหนดค่าพารามิเตอร์ต่างๆ ของระบบ มีรายละเอียดขอ้มูลในไฟลด์งัน้ี 

;%db%.prm 
;!!!CAUTION!!! 
; Changes in this file need reindexing, and may cause database integrity problem. 
 

; alttag, library defined browseable tag. 
[alttag]     →ก าหนดให ้tag ในรายการดา้นล่างน้ีสามารถสืบคน้แบบ browse ได ้นอกจาก field หลกั 
16=x 
910=x 
930=x 
950=x 
 

[index]  →ก าหนดเลขหมู่หลกั 
PrimaryCallNumber=082 
 

[settings] 
; db035=035prefix →ก าหนดรูปแบบค าน าหนา้ของ tag 035 ปกติจะข้ึนตน้ดว้ยช่ือฐานขอ้มูล 
; SubfieldA -1:Remove, 0:Leave, 1:Add →ก าหนดการแสดง subfield A  
SubfieldA=0 
; elib_tag=998, \aAForm\cCreator\eEntrDate\mModifier\uUpdtDate→ก าหนดใหเ้ก็บ fix field ไวใ้น tag 998 ดว้ย 
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กำรก ำหนดรูปแบบของรำยงำน  (Report Setup) 
 

 การก าหนดรูปแบบรายงานของระบบห้องสมุดอตัโนมติั ในส่วนรายงานของระบบ Cataloging Module และ มี
รายละเอียดดงัน้ี 

รำยงำนของระบบ Cataloging Module 
 ในส่วนของ Cataloging Module การก าหนดรูปแบบรายงาน สามารถท าไดโ้ดย ใชโ้ปรแกรม Text Editor เช่น 
Notepad หรือ WordPad เปิดไฟล ์ช่ือ RtReport.iniซ่ึงเก็บอยูท่ี่ “\ELIB\Tools\” 
 ในเบ้ืองต้น ระบบจะก าหนดค่าท่ีถูกต้องไวแ้ล้ว ก่อนท่ีจะมีการแก้ไขควรส ารองไฟล์ไวก่้อน และเม่ือท า 
การแกไ้ขแลว้ บนัทึกค่าอีกคร้ัง  
 ค่าเร่ิมตน้ท่ีระบบก าหนดค่าไว ้สามารถแกไ้ขได ้โดยการยกเลิกเคร่ืองหมาย;หนา้บรรทดั แลว้แกไ้ขขอ้มูล ท่ีอยู่
ด้านขวาของเคร่ืองหมาย = เช่น จาก รำยงำนทรัพยำกรใหม่ท่ีผ่ำนกำรตรวจสอบ ถา้ตอ้งการแก้ไข ค่าของ Title name 
สามารถท าไดด้งัน้ี 

ค่ำเดมิ   ; Title="New entry in database" 
ค่ำทีแ่ก้ไขแล้ว  Title="รายงานทรัพยากรใหม่ท่ีผา่นการตรวจสอบ" 

ตวัอยา่งขอ้มูล ใน RTReport.ini  
[NEW_IN_DB]    →รายงานทรัพยากรใหม่ท่ีผา่นการตรวจสอบ 

title=New record in DB →Label ของ ช่ือรำยงำน  
label1=From :  → Label ของ   From 
label2=To :  → Label ของ  To 
column1=Bib Id.  → Label ของ Column ท่ี 1 
column2=Call Number → Label ของ Column ท่ี 2 
column3=Title  → Label ของ Column ท่ี 3 
begin=BEGIN  → Label ของ BEGIN 
end=END   → Label ของ END 

 

[NEW_IN_BUF]    →รำยงำนทรัพยำกรใหม่ท่ียงัไม่ผ่ำนกำรตรวจสอบ 
title=New record in buffer → Label ของ ช่ือรำยงำน 
label1=From :  → Label ของ From 
label2=To :  → Label ของ To 
column1=Buffer Id.  → Label ของ column 1 
column2=Call Number → Label ของ column 2 
column3=Title  → Label ของ column 3 
begin=BEGIN  → Label ของ BEGIN 
end=END   → Label ของ END 
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[BIB_CATALOGCARD]  →ค่ำเร่ิมต้นของ บัตรรำยกำร  
- - Part 1: Card Format- -  
Portrait=0 →0 : พิมพ์รำยกำรโดยใส่บัตรในแนวนอน(Default) 
Portrait=1 →1 : พิมพ์บัตรรำยกำรโดยใส่บัตรในแนวตั้ง และก ำหนดค่ำต่ำง ๆ ได้จำก 
 

- - Part 2: Page setup - -  
FontFace=Angsana New รูปแบบฟอนต์ ท่ีต้องกำรให้แสดงบนบัตรรำยกำร 
PaperWidth=8640 →ควำมกว้ำงของหน้ำกระดำษ 
PaperHigh=0 →ควำมสูงของหน้ำกระดำษ 
MarginLeft=907 →ขอบซ้ำยของกระดำษ 
MarginRight=1440 →ขอบขวำของกระดำษ 
MarginTop=238 →ขอบบนของกระดำษ 
MarginBottom=902 →ขอบล่ำงของกระดำษ 
 

- - Part 3: Card setup - -  
C1Width=1040 →ควำมกว้ำงของ column ท่ี 1 
C2Width=40 →ควำมกว้ำงของ column ท่ี 2 
C3Width=6120 →ควำมกว้ำงของ column ท่ี 3 
C3Break=5750 →ค่ำท่ีโปรแกรมใช้ในกำรค ำนวณตัวอักษรท่ีจะให้ปรำกฏใน Column ท่ี 3ควรจะ
  ก ำหนดค่ำให้น้อยกว่ำค่ำใน  C3Width ประมำณ 180  
R1Line=6 →จ ำนวนบรรทัดในแถวท่ี 1 
R2Line=4 →จ ำนวนบรรทัดในแถวท่ี 2 
LineHigh=360 →ควำมสูงของบรรทัด 
CardHigh=4260 →ควำมสูงของบัตรรำยกำร 
HoleLeft=3347 →ต ำแหน่งของรูร้อยบัตรวดัจำกขอบด้ำนซ้ำยของบัตรรำยกำรจนถึงขอบซ้ำย 
   ของรูร้อยบัตร 
HoleBottom=4000 →ต ำแหน่งของรูร้อยบัตรวดัจำกขอบด้ำนบนของบัตรรำยกำรจนถึงขอบล่ำง 
  ของรูร้อยบัตร 
HoleWidth=340 →ควำมกว้ำงของรูร้อยบัตร (เส้นผ่ำนศูนย์กลำง) 
 

- - Part 4: Indent setup - -  
li  →Left indent  
ri  →Right indent 
ii, ii1  →ย่อหน้ำของรำยกำรท่ัวไป  
mi, mi1  →ย่อหน้ำแรกในบัตรทะเบียน และบัตรผู้แต่ง 
si, si1  →ย่อหน้ำแรกในบัตรหัวเร่ืองและบัตรผู้แต่ง 
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xi , xi1   →ย่อหน้ำแรกในบัตรต่อเน่ือง 
mti, mti1  →ย่อหน้ำท่ีสองในบัตรทะเบียน (กรณีไม่มรีำยกำรผู้แต่งหลกั) , บัตรผู้แต่ง (กรณี 

   ไม่มรีำยกำรผู้แต่งหลกั), บัตรหัวเร่ือง (กรณีไม่มรีำยกำรผู้แต่งหลกั) และ บัตร     
   ช่ือเร่ือง (กรณีไม่มรีำยกำรผู้แต่งหลกั) 
 

การก าหนดค่าของยอ่หนา้สามารถท าได ้โดยก าหนดค่าของ Parameter ?i และ ?i1 โดยมีรูปแบบดงัน้ี 
- ถา้ ?i มีค่ามากกวา่ ?i1 เช่น mi = 320,  mi1 = 0 การยอ่หนา้จะเป็นดงัน้ี 
 

         mi  = 320                     |xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx  
         mi1 = 0    xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx  
 

- ถา้ ?i มีค่านอ้ยกวา่ ?i1 เช่น mi = 0,  mi1 = 320 การยอ่หนา้จะเป็นดงัน้ี 
 

         mi  = 0    xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx  

         mi1 = 320                     |xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx  
 

- - Part 5: Other setup - -  
ExactHigh=1  →0= ; 1= 
ROMANNUM=1  →0 = ตัวเลข ; 1=อักษรโรมนั ในกรณีท่ีเป็นตัวเลข จะนับต่อจำกเลขก่อนหน้ำ  
   แต่ในกรณีท่ีเป็นอักษรโรมนัจะเร่ิมจำก I, II, III,… 
Grid=1   →0 =ไม่แสดงเส้นขอบบัตรรำยกำร ; 1 = แสดงเส้นขอบบัตรรำยกำร 
   กำรแสดงเส้นขอบบัตรรำยกำรจะใช้ในกรณีท่ีพิมพ์บัตรรำยกำรบน 
         กระดำษธรรมดำ 
Hole=1   →0 =ไม่แสดงรูร้อยบัตรรำยกำร ; 1 = แสดงรูร้อยบัตรรำยกำร 
CalTag=0   →0=ใช้ Primary Call Number ; หรือระบุ  Call Number TAG  
AccTag=16  →ระบุ  Accession Number TAG เช่น 016 
NteTag=500  →ระบุ Note TAG เช่น 500 
Title0=”Title”  →ข้อควำมท่ีต้องกำรแสดงในแนวสืบค้น ส ำหรับบัตรภำษำอังกฤษ 
Title1=”ช่ือเร่ือง”  →ข้อควำมท่ีต้องกำรแสดงในแนวสืบค้น ส ำหรับบัตรภำษำไทย 
etc0=”etc”  
etc1=”ฯลฯ” 
ExCard0=”(Card %d)” 
ExCard1=”(บตัรท่ี %d)” 
Continue0=”(Continued on next card)” 
Continue1=”(มีต่อในบตัรต่อไป)” 
ISBN=”ISBN” 
CalSubfield=abdce 
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กำรถ่ำยโอนข้อมูลระหว่ำงแม่ข่ำยกบัลูกข่ำย 
โดยจะแบ่งเป็น 2 โปรแกรมในการตั้งค่าและในการถ่ายโอนขอ้มูลElib.exe และ FTClient ดงัน้ี 

ELIB.exe 
1. โปรแกรม Elib.exe จะเป็นโปรแกรมส าหรับตั้งค่าใหก้บัการถ่ายโอนขอ้มูลและอ่ืนๆ เม่ือเปิดโปรแกรมข้ึนมาจะปรากฏ
ดงัภาพ 
 
 
 
 
 
 
 
 
 
 
2.เลอืก File > Connect  > Setup เพื่อท ำกำรเชื่อมต่อกบัเครื่องแมข่ำ่ย > Add จะปรำกฏหน้ำต่ำง Add/edit folder map 

 
 

Display name :  ช่ือแทนเรียกเคร่ืองแม่ค่าย 
Server name/address : ไอพีของเคร่ืองแม่ข่ายหรือช่ือเคร่ืองแม่ข่าย 
Server Port :  พอร์ตท่ีใชเ้ช่ือมต่อกบัเคร่ืองแม่ขา่ย โดยจะใชพ้อร์ต 80 

 
3. เม่ือท าการตั้งค่าเรียบร้อยแลว้ กลบัมาท่ีหนา้  login to elib server จะปรากฏดงัภาพ โดยท่ีช่อง Database จะปรากฏค าวา่  
Refresh ใหท้ าการ Refresh จะปรากฏ Database ของเคร่ืองแม่ข่าย และท าการ login  (User จะตอ้งมีสิทธิในการใช ้File 
Transfer) 
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4. ท าการเลือกไอคอน “C” (Configuration) เพ่ือท าการตั้งค่าการถ่ายโอนขอ้มูล (File Transfer) ดงัภาพ 
 

 
 
  File Count limit :  จ านวนไฟลท่ี์จ ากดัในการถ่ายโอนขอ้มูลแต่ละคร้ัง 
  File size limit :  ขนาดของไฟลท่ี์จ ากดัในการถ่ายโอนขอ้มูล 
  File type default :  ตั้งค่าในการอนุญาตและไม่อนุญาตในบางสกลุไฟล ์
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  File type allow :  ไฟลท่ี์อนุญาตในการถ่ายโอนขอ้มูล 
  File type deny :  ไฟลท่ี์ไม่อนุญาตในการถ่ายโอนขอ้มูล 
  Folder map :  โฟลเดอร์ท่ีไดท้ าการ map ไว ้
 
5. เลือก Add เพื่อกรอก Display name และ Path on server เลือก Directory ของโฟลเดอร์ท่ีตอ้งการ map เลือก OK   
 
 
 
 
 
 
 
 
6. เลือก Save  
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Multimedia 

 
 
  File size limit :  ขนาดของไฟลท่ี์จ ากดัในการถ่ายโอนขอ้มูล 
  File type allow :  ไฟลท่ี์อนุญาตในการถ่ายโอนขอ้มูล 
  Folder map :  ตั้งค่าโฟรเดอร์ท่ีตอ้งการ 
  Up/Down :  จดัล าดบั 
  Delete :   ลบขอ้มูล 
  Edit/Add :  แกไ้ข เพ่ิม 
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1. เลือก Add จะปรากฏหนา้ต่างดงัภาพ 
 

   
 
 
 
 
 
 
 
 
 
 

Group  :  ช่ือยอ่ของประเภทไฟล ์
  Label (0) : ช่ือประเภทของไฟลภ์าษาองักฤษ 
  Label (1): ช่ือประเภทของไฟลภ์าษาไทย 
  Server path : สถานท่ีจดัเก็บไฟล ์
  WWW path : สถานท่ีจดัเก็บไฟลบ์น WebServer 
  Captcha : รูปแบบการเขา้ถึงไฟลแ์บบกรอกตวัอกัษรตามภาพ 
  Password : รูปแบบการเขา้ถึงไฟลแ์บบระบุบรหสัผา่นสมาชิก 
  Information : รูปแบบการเขา้ถึงไฟลแ์บบกรอกขอ้มูลแบบสอบถาม 
  Direct link : รูปแบบการเขา้ถึงไฟลแ์บบโดยตรง 
  Read Only : รูปแบบการเขา้ถึงไฟลแ์บบเปิดไดท้นัที 
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Cover 

 
 
  File size limit :  ขนาดของไฟลท่ี์จ ากดัในการถ่ายโอนขอ้มูล 
  File type allow :  ไฟลท่ี์อนุญาตในการถ่ายโอนขอ้มูล 
  Server path :  สถานท่ีจดัเก็บไฟล ์
  WWW path :  ลิงคเ์ช่ือมโยงเวบ็ไซต ์
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Patron 

 
 

Enable Alternate ID.  : เปิดใชง้านบตัรสมาชิกแบบ บตัรประชาชน 
Enable Patron Title  : เปิดใชง้านค าน าหนา้ช่ือ/ชั้นยศ 

  Allowed Domain User  : เปิดใชง้านระบบผูใ้ชโ้ดเมน  
  Patron Photo 
  File size limit :  ขนาดของไฟลท่ี์จ ากดัในการถ่ายโอนขอ้มูล 
  File type allow :  ไฟลท่ี์อนุญาตในการถ่ายโอนขอ้มูล 
  Server path :  สถานท่ีจดัเก็บไฟล ์
  WWW path :  ลิงคเ์ช่ือมโยงเวบ็ไซต ์
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Calculation 

 
 

 Fine Calculation   :  ตั้งค่าไม่ใหค้  านวณค่าปรับในวนัหยดุ 
 For Circulation Client  : ตั้งค่าระยะเวลาระหวา่งเซิฟเวอร์กบัลูกข่าย 
 Hold Calculation skip holiday  :  ตั้งค่าใหไ้ม่ค านวณการจองในวนัหยดุ 
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      Item 

 
 

Allowed duplicate access No. :  เลือกเพ่ือตั้งค่าใหส้ามารถใชง้านAccession no. ซ ้ าได ้
 Optional fields   : สามารถตั้งค่าเปล่ียนแปลงค าท่ีจะใชแ้ทนนั้นๆได ้
 ItemNo Length   : ก าหนดจ านวนหลกัของตวัเล่ม 
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Item-CDesc 
ปรับแตง่การแสดงผลหนา้ไอเทม 
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Item – CMenu List  
ปรับแตง่การแสดงผลไอเทมหนา้รายการตวัเล่ม 
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ItmMgr List 
ปรับแตง่การแสดงผลไอเทมหนา้ เพ่ิมไอเทม 
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ItmMgr Delete 
ปรับแตง่การแสดงผลไอเทมหนา้ลบไอเทม 
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Log 
เปิดการตั้งค่าส าหรับเก็บขอ้มูลการสืบคน้ 

 

 
Marc Catalog 

เพ่ิม tag ส าหรับการ lookup 
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Web 
ตั้งค่าการแสดงผลตวัเล่มในหนา้เวบ็หลกั 

 
 

 Top circulation 

  Include Item Class: ก าหนดประเภททรัพยากรยอดนิยมท่ีตอ้งการใหแ้สดงผล 
  Day to analyze:  แสดงผลยอ้นหลงัของทรัพยากรยอดนิยมตามจ านวนวนัท่ีก าหนด 

 New arrival 
  By Date of :   ก าหนดใหแ้สดงโดยอิงจาก รายการใหม่,รายการท่ีแกไ้ข,ตวัเล่มใหม่ 
  IncludeItemClass : ก าหนดประเภททรัพยาการใหม่ท่ีตอ้งการใหแ้สดงผล 
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OPAC 

 
 

 Native Call number browse.: เปิดใชง้านการแสดงผลตามเลขเรียกหนงัสือ 
 Allowed HTML embedded : เปิดใชง้านการแสดงผลรูปแบบ html ในรายการบรรณานุกรม 
 Same authority link:  ปรับรูปแบบการแสดงผลรายการหลายผูแ้ต่ง 
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ELIB 

 
 

ELIB Server  : กรอกไอพีหรือช่ือเรียกเคร่ืองเซิร์ฟเวอร์ของหอ้งสมุด 
Case Insitive : เปิดใชง้าน เม่ือตอ้งการใหร้ะบบอนุญาติท ารายการตวัเล่มท่ีรหสัตวัเล่มแสดงผลไม่ตรงกบัใน
   ฐานขอ้มูล 
Date time format : ก าหนดรูปแบบการแสดงผลของวนัท่ีในส่วนของ งานยมืคืนออนไลน์ 
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Item media 
เปิดการใชง้านเช่ือมโยงหนา้ปกตวัเล่มโดยมีวธีิการตั้งค่าดงัน้ี 
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  File size limit :  ก าหนดขนาดไฟลท่ี์อพัโหลด 
  File Type allow :  ก าหนดสกลุไฟลท่ี์สามารถอพัโหลดได ้

 Folder map 

  Group  :  ก าหนดช่ือยอ่ 
  Label (0)  :  ก าหนดช่ือท่ีตอ้งการแสดงเป็นภาษาองักฤษ 
  Label (1)  :  ก าหนดช่ือท่ีตอ้งการแสดงเป็นภาษาไทย 
  Server Path :  ก าหนดสถานท่ีจดัเก็บไฟล ์
  WWW Path :  ก าหนดสถานท่ีจดัเก็บรูปแบบออนไลน์ 
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FTClient 
1. เปิดโปรแกรม FTClient จะปรากฏดงัภาพ โดยโปรแกรมจะแบ่งเป็น 2 ส่วนดา้นซา้ยเป็นเคร่ืองลูกข่าย ดา้นขวาเป็นเคร่ือง
แม่ข่าย 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. เลือก View > Setting เพ่ือตั้งค่าใหเ้ช่ือมต่อกบัเคร่ืองแม่ข่าย Server list ใหใ้ส่ไอพีเคร่ืองแม่ข่ายและพอร์ตท่ีใชใ้นการ
เช่ือมต่อ เช่น พอร์ต80 ดงัภาพ จากนั้นเลือก OK 
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3. ใหท้ าการเลือกปุ่ม Server > Connect จะปรากฏหนา้ต่าง Login ในช่อง Database ใหท้ าการเลือก Refresh หน่ึงคร้ังจะ
ปรากกฎ Database ของเคร่ืองแม่ข่าย (User ท่ี login จะตอ้งมีสิทธิในการใชง้าน File Transfer)  
 

 
4. หลงัจาก login จะปรากฏโฟลเดอร์บนเคร่ืองแม่ข่ายท่ีไดต้ั้งค่าไวแ้ลว้ คลิกหน่ึงคร้ังท่ีโฟลเดอร์จะปรากฏไฟลต์่างๆภายใน
โฟลเดอร์และใหค้ลิกเลือกโฟลเดอร์ปลายทางท่ีตอ้งการ Upload  
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5. จากนั้นใหเ้ลือกไฟลท่ี์ตอ้งการจะถ่ายโอนไปยงัเคร่ืองแม่ข่ายแลว้เลือก Enqueue ไฟลท่ี์เลือกแลว้จะปรากฏอยูด่า้นล่างเพ่ือ
เตรียมพร้อมส าหรับการ Upload  ในแถบดา้นล่างจะบอกรายละเอียดต่างๆของไฟลท่ี์เลือกจะ Upload  แถบ Destination จะ
บอกโฟลเดอร์ปลายท่ี ท่ีจะถ่ายโอนขอ้มูลไปยงัเคร่ืองแม่ข่าย 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
6. ใหท้ าการคลิกขวาไฟลท่ี์ไดเ้ลือกไวแ้ลว้  เลือก Upload ไฟลก็์จะถูกถ่ายโอนไปยงัเคร่ืองแม่ข่าย 
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BatchTools 
 

1.เขา้ไปท่ี D:\ELIB\tools   ดบัเบ้ิลคลิก BatchTools.exe ไดห้นา้จอดงัภาพ 

 
2. คลิกเมนู File > Connect  
เลือก  Database: Main 
 จากนั้นระบุ User และPassword   

เม่ือ Connect ได ้จะแสดงขอ้มูล จ านวน BibCount , ItemCount, PatronCount 
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3. คลิกท่ีเมนู Hold > Process จะแสดง list รายช่ือสมาชิกท่ีจะส่ง Email แจง้เตือน ดงัภาพ 

 
 

คลิกปุ่ม Process เพ่ือท าการส่ง Email แจง้การรับหนงัสือจอง 
เม่ือโปรแกรม Run เสร็จเรียบร้อย ใหค้ลิกปุ่ม Close 
4.คลิกเมนู Circulation > Due notice  แสดงดงัภาพ 
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คลิกปุ่ม Apply จะแสดงรายช่ือสมาชิกท่ีจะถึงก าหนดการคืนหนงัสือ 
คลิกปุ่ม Process เพ่ือท าการส่ง Email แจง้เตือนการคืนหนงัสือ 
เม่ือโปรแกรม Run เสร็จเรียบร้อย ใหค้ลิกปุ่ม Close 
5. ออกจากระบบ โดยคลิกท่ีเมนู File > Disconnectและปิดโปรแกรม 
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โปรแกรมแก้ไขเลขบำร์โค้ด เลขสมำชิกและรหัส 
CircTools 
 1. เปิดโปรแกรม Circtools ข้ึนมาจะปรากฏหนา้ต่างดงัภาพ 

 
 
2.  เลือก Database > Connect จะปรากฏหนา้ login ใหเ้ลือก Database ท่ีตอ้งการจะแกไ้ข กรอก User และ Password 
(User จะตอ้งมีสิทธิเป็น System admin)  
3. เล่ือนเมาส์ไปคลิกท่ีรูปคนจะปรากฏหนา้ต่าง Update Patron Id. ดงัภาพ 
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  Current Patron Id. : รหสัสมาชิกเดิมท่ีตอ้งการจะเปล่ียน 
  New Patron Id. :  รหสัสมาชิกใหม่ท่ีตอ้งการเปล่ียน 
  New Patron password : รหสัผา่นของสมาชิกท่ีตอ้งการเปล่ียน 
  Display password :  คลิกเพ่ือแสดง รหสัผา่น 
  Patron’s information : แสดงขอ้มูลของสมาชิก 
4. เม่ือกรอกขอ้มูลครบถว้นแลว้ใหเ้ลือก Process 
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กำรรวมข้อมูลใน TAG ทีซ่ ้ำกนั 
 ในขั้นตอนการท างาน Cataloging มกัจะเกิดปัญหาในการสร้างขอ้มูลใน TAG ซ ้ ากนั ใน Category ช่ือเร่ือง ช่ือผู ้
แต่ง หรือหวัเร่ือง เช่น การใส่เคร่ืองหมายลูกน ้ า (,) หรือ เคร่ืองหมายจุดไขป่ลา (.) หรือการเคาะเวน้วรรคไม่เท่ากนั ท าให้
เกิดผลกระทบในการคน้หาผลลพัธ์ต่างๆ ในการสืบคน้ท่ีจะท าใหไ้ดข้อ้มูลไม่ครบถว้น 
 ซ่ึงระบบบหอ้งสมุดอตัโนมติั ELIB สามารถรวม TAG ท่ีซ ้ าซอ้นกนัเหล่าน้ีได ้
ขั้นตอนกำรรวมข้อมูลใน TAG ทีซ่ ้ำกนั 
1. เปิดโปรแกรม ElibTools.exe (บนหนา้จอ Desktop หรือ D:\ELIB\tools) 

 
รูป ไอคอนโปรแกรม ElibTools 

 

2. ท าการเช่ือมต่อกบั Server ดว้ยการคลิกท่ีปุ่ม   ดงัรูปภาพดา้นล่าง 
 
 
 
 
 
 
 
 

รูป หนา้ต่างส าหรับเช่ือมต่อระบบเขา้กบั Server 
3. เลือกฐานขอ้มูลท่ีตอ้งการใชง้าน กรอก USERNAME และ PASSWORD ตามภาพดา้นล่าง 
 
 
 
 
 
 
 

 
รูปกรอก USERNAME และ PASSWORD เพ่ือเขา้สู่ระบบ 



 
บริษัท บุ๊คโปรโมช่ันแอนด์เซอร์วสิ จ ำกดั 
เลขที่ 8ซอยกรุงเทพกรีฑำ8แยก8 แขวงหัวหมำกเขตบำงกะปิ  กรุงเทพมหำนคร  10240  

Tel: 0-2769-3888     Fax: 0-2379-5182 
 

    
   คู่มือกำรปฏิบัตงิำนระบบห้องสมดุอตัโนมตั ิ ELIB79  
 

4.หลงัจากท าการลอ็กอินเขา้สู่ระบบแลว้ ใหเ้ลือกเมนู Tools > Authority Manage … ดงัภาพดา้นล่าง 

รูป เมนู Authority Manage 
5. สามารถเลือกจ ากดัเขตขอ้มูลไดต้ามเมนูต่างๆ ตามค าอธิบายดงัท่ีปรากฏในภาพดา้นล่าง  

รูปเคร่ืองมือต่างๆ ในเมนู Authority Manage 
• Category : สามารถ Drop down เพื่อเลือก TAG ท่ีตอ้งการรวมได ้ไดแ้ก่ Author, Subject, Title และ Tag Number  

• Start from :ใส่พยญัชนะ เช่น ก-ฮ หรือ Tag ตาม Category และสามารถเลือกจ ากดัเขตขอ้มูลแบบ List same key 
set หรือ List all ไดข้อ้มูลจะปรากฎตามพยญัชนะ 

 
 
 
 
 
 
 
 
 
 
 

o List same key set ; ระบบจะประมวลผลคียเ์วร์ิดท่ีใกลเ้คียงกนัมาใหเ้ป็นชุด และแยกสีในแต่ละบรรทดั 
o List all ; ระบบจะประมวลผลคียเ์วร์ิดมาใหต้ามล าดบัการไล่เรียงของตวัอกัษร  
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• Start from : สามารถระบุขอ้มูลเร่ิมตน้ได ้เช่น เลข TAG หรือ หวัเร่ืองท่ีตอ้งการ เป็นตน้ 
 
 

• Top : สามารถระบุจ านวนเลขท่ีจะใหแ้สดงผลในแต่ละคร้ังได ้จะพิมพต์วัเลขเองหรือใชลู้กศรข้ึน-ลงเพื่อระบุ
จ านวนก็ได ้

 
6. จ ากดัเขตขอ้มูลท่ีตอ้งการในส่วนต่างๆ จากนั้นกดท่ีปุ่ม Apply ทางขวามือ 
 
 
 
 

รูป จ ากดัเขตขอ้มูลท่ีตอ้งการรวมเขา้ดว้ยกนั 
7. เม่ือกดปุ่ม Apply แลว้ ระบบจะท าการประมวลผลขอ้มูลท่ีซ ้ ากนัออกมา ดงัท่ีปรากฏในภาพดา้นล่าง 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูประบบประมวลขอ้มูลท่ีซ ้ ากนัใน TAG 650 
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8. กดปุ่ม CTRL บนคียบ์อร์ดคา้งเอาไว ้และเลือกขอ้มูลท่ีตอ้งการรวมเขา้ดว้ยการดว้ยการคลิกเมาส์ซา้ยจนข้ึนเป็นแถบสีน ้ า
เงิน จากนั้นคลิกขวา จะปรากฏตวัเลือกต่างๆ ใหค้ลิกท่ี Merge… 

รูปขอ้มูล TAG 650 ท่ีซ ้ ากนั แต่กลายเป็น 2 หวัเร่ือง  
9. เม่ือเลือกแลว้จะปรากฏหนา้ต่างดงัภาพดา้นล่าง เลือกขอ้มูลท่ีถูกตอ้ง หรือขอ้มูลตอ้งการใชใ้หเ้ป็นแถบสีน ้ าเงิน จากนั้น
คลิกปุ่ม OK ระบบจะท าการประมวลผล ขอ้มูลท่ีซ ้ ากนัจะหายไป และสามารถท าการรวมขอ้มูลอ่ืนๆ ท่ีซ ้ ากนัต่อไดท้นัที 
 
 
 
 
 
 
 
 
 
 
 
 

รูปเลือกแถบสีน ้ าเงินบนขอ้มูลท่ีตอ้งการใชง้าน และเลือก OK 
 
 
 



 
บริษัท บุ๊คโปรโมช่ันแอนด์เซอร์วสิ จ ำกดั 
เลขที่ 8ซอยกรุงเทพกรีฑำ8แยก8 แขวงหัวหมำกเขตบำงกะปิ  กรุงเทพมหำนคร  10240  

Tel: 0-2769-3888     Fax: 0-2379-5182 
 

    
   คู่มือกำรปฏิบัตงิำนระบบห้องสมดุอตัโนมตั ิ ELIB82  
 

Authority Manage with tag 

 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
5. สามารถเลือกจ ากดัเขตขอ้มูลไดต้ามเมนูต่างๆ ตามค าอธิบายดงัท่ีปรากฏในภาพดา้นล่าง  
 

 

 
รูปท่ี 2 เคร่ืองมือต่างๆ ในเมนู Authority Manage with Tag  

• Category : สามารถ Drop down เพ่ือเลือกเขตขอ้มูลไดแ้ก่ Author, Subject, Title, ISBN/ISSN, URL และ Tag 
Number  

• Option :  สามารถเลือกจ ากดัเขตขอ้มูลท่ีตอ้งการใหแ้สดง  
o List all ระบบจะประมวลผลมาใหต้ามล าดบัการไล่เรียงของตวัอกัษร 
o List same Key set ระบบจะประมวลผลคียเ์วร์ิดท่ีใกลเ้คียงกนัมาใหเ้ป็นชุด และแยกสีในแต่ละบรรทดั 

• Like : สามารถประมวลขอ้มูลท่ีวา่ง จนถึงคียเ์วร์ิดค าแรกใหป้รากฎได ้
• Locate : สามารถใส่พยญัชนะหรือคียเ์วร์ิดของค าแรกท่ีตอ้งการคน้หาได ้เช่น ตวัเลข 0-9,ก-ฮ, A-Z  เป็นตน้  
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• Top : สามารถระบุจ านวนท่ีตอ้งการใหข้อ้มูลแสดงผลไดซ่ึ้งรองรับสูงสุดตั้งแต่ 0-99999 
•  Apply : เมือกดปุ่ม Apply ระบบจะประมวลผลขอ้มูลซ ้ า หรือขอ้มูลท่ีตอ้งการแกไ้ข  

 

6. จ ากดัเขตขอ้มูลท่ีตอ้งการในส่วนต่างๆ จากนั้นกดท่ีปุ่ม Apply ทางขวามือ 
 

 

 
 

 

รูปท่ี 3 การจ ากดัเขตขอ้มูลท่ีตอ้งการรวมเขา้ดว้ยกนั 

7. เม่ือกดปุ่ม Apply แลว้ ระบบจะท าการประมวลผลขอ้มูลท่ีซ ้ ากนัออกมา ดงัท่ีปรากฏในภาพดา้นล่าง 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

รูปท่ี 4  ระบบประมวลขอ้มูลท่ีซ ้ ากนัใน Subject  
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8. กดปุ่ม CTRL บนคียบ์อร์ดคา้งเอาไว ้และเลือกขอ้มูลท่ีตอ้งการรวมเขา้ดว้ยการดว้ยการคลิกเมาส์ซา้ยจนข้ึนเป็นแถบสีน ้ า
เงิน จากนั้นคลิกขวา จะปรากฏตวัเลือกต่างๆ ใหค้ลิกท่ี Merge… 

 

 

 

 

 

 

 

 

รูปท่ี 5 ขอ้มูล Subject ท่ีคล้า้ยกนั  

9. เม่ือเลือกแลว้จะปรากฏหนา้ต่างดงัภาพดา้นล่าง เลือกขอ้มูลท่ีถูกตอ้ง หรือขอ้มูลตอ้งการใชใ้ห้เป็นแถบสีน ้ าเงิน จากนั้น
คลิกปุ่ม OK ระบบจะท าการประมวลผล ขอ้มูลท่ีซ ้ ากนัจะหายไป และสามารถท าการรวมขอ้มูลอ่ืนๆ ท่ีซ ้ ากนัต่อไดท้นัที 

 
 

 

 

 

 

 

 

 

รูปท่ี 6  เลือกแถบสีน ้ าเงินบนขอ้มูลท่ีตอ้งการใชง้าน และเลือก OK 
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10. นอกจากการประสานขอ้มูล (Merge) ระบบมี Option ในการจดัการขอ้มูล  เช่น แกไ้ขเขตขอ้มูล (Tag), ตวับ่งช้ี 
(Indicator), เน้ือหา (Text) รวมถึงสามารถน าออก(Export)  หรือเช่ือมโยงไปยงัรายการบรรณานุกรม (Link to bib record) 
ของรายการท่ีตอ้งการแกไ้ขไดด้งัตวัอยา่งรูปภาพดา้นล่าง  

 

 

 
 
 
 

  

รูปท่ี10 Option การจดัการขอ้มูล 

 

 

 

รูปท่ี7 Option การจดัการขอ้มูล 
 

1. Merge…: การประสานขอ้มูลในเขตขอ้มูลทั้งหมด  
2. Edit…:  การแกไ้ขเขตขอ้มูล Authority Global Edit  สามารถแกไ้ข Tag, Indicator, Subfieldและ Text 
3. Select all  : สามารถเลือกขอ้มูลทั้งหมดได ้ 
4. Link to Bib record…: สามารถเช่ือมโยงไปยงัรายการบรรณานุกรมในงานการลงรายการ (Catalog) เพื่อ

แกไ้ขเพ่ิมเติมได ้
5. Remove from list : สามารถยา้ยขอ้มูลท่ีปรากฏออกไปชัว่คราวได ้ 
6. Refresh  : การเคลียร์ขอ้มูลในการท างาน 
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11. Authority Global Edit การแกไ้ขเขตขอ้มูล ตวับ่งช้ี และขอ้ความ ซ่ึงหากมีรายการเช่ือมโยง (Link) หลายรายการ ทุกๆ

รายการเช่ือมโยงจะถูกแกไ้ขดว้ยทั้งหมด **Edit all records linked to this entry. 
 
 

 
 
 

 
 

  
 
  
  
 
 
 
 
 
 

รูปท่ี 8 หนา้จอการแกไ้ขขอ้มูล Authority Global Edit 
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10. เม่ือใชง้านโปรแกรมเสร็จเรียบร้อยแลว้ ตอ้งท าการ Disconnect ทุกคร้ังเพ่ือตดัการเช่ือมต่อก่อนปิดโปรแกรม โดยการ

เลือกท่ีปุ่ม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูปDisconnect เพ่ือตดัการเช่ือมตอ่ก่อนปิดโปรแกรม 
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